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Lab 06 — Introduction to the Application Diagram Viewer

Overview

This tutorial teaches you how to use the Application Diagram Viewer to visualize the structure and flow
of native IBM i® applications. Using sample IBM i programs that are provided with the tutorial, you will
work with the Source Call Diagram and Program Structure Diagram views to understand the structure
of those programs. Then you will navigate through the application diagram to edit the source code,
change settings, and add notes to a diagram.

Learning objectives

Create an application diagram for selected IBM i program objects or source members.
Use the Outline view to navigate the diagram.

View and edit the source members associated with nodes in the application diagram
Annotate the diagram

Change an application diagram’s default settings

Save and print the application diagram

AN

Skill level and prerequisites
Introductory.
Important!

You should complete RDi Lab01 ‘Getting started’ before you work on this lab. Lab01

contains the following information and instructions:
e  Which IBM i server to connect to

e  Which User ID to use
e How to start RDi, create a connection and connect

e How to setup the correct library list for this lab

Knowledge of basic Microsoft Windows operations such as working with the desktop, mouse operations
such as opening folders and drag-and-drop is assumed. It will also be helpful if you understand DDS and
ILE RPG.
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Conventions used in this workbook

Bold font is used to highlight user interface controls
Mono-spaced font is used for user input text and code blocks
Italic font is used for variable names and glossary terms

The following icons are also used to identify categories of information:

Icon Purpose Explanation
This symbol calls attention to a particular step or command.
A Important! For example, it might alert you to type a command carefully
because it is case sensitive.
t. Information This symbol indicates information that might not be necessary
L to complete a step but is helpful or good to know.
Trouble- This symbol indicates that you can fix a specific problem by
shooting completing the associated troubleshooting information.

Client System requirements

The labs require IBM Rational Developer for IBM i (RDi) to be installed on your workstation. If you do
not yet have this, you can download it for free from http://ibm.biz/rdi_trial.

Host System requirements

The easiest way to ensure you have everything you need, is to use the demonstration IBM i server that is
set up and ready to use with these lab exercises. These labs use the RSELABxx library on that system. For
those who want to run these labs on to their own system, you can load a SAVF with the RSELABxx
library from rselabxx.savf.
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1 Introduction

In this tutorial, you learn how to use the Application Diagram Viewer with IBM 1 application resources
and make changes to the generated diagram.

When you need to change an existing IBM i native application, you can gain a better understanding of the
connections between resources by viewing a graphical representation rather than looking at source code.
The Application Diagram Viewer helps you navigate easily among related IBM i resources and links to
those resources to allow viewing and editing in the Remote Systems LPEX editor. This includes a
diagram to display the call graph for CL, ILE RPG and ILE COBOL resources and a diagram to show the
binding relationships for program and service program objects.

An application diagram is made up of nodes and connections. Nodes represent different resources in your
application; connections represent the relationship between those artifacts.

nodes

{ process

\ connections /

¥ 5 TPARTR RPGLE ' s ! endpom

You will create an application diagram, for an existing Order Entry application, using the default
diagram layout. You will learn how to change those default settings.

You will use the Outline view to navigate through the generated application diagram and view source
code by launching the Remote Systems LPEX editor from the diagram. You will change the application
diagram’s visual style and document the diagram by adding notes to the diagram. To keep those changes,
you will save the application diagram in several file types. Saving to a workspace file allows you to
reopen the application diagram at a later time.
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2 The Application Diagramming environment

This picture shows the views that you will use when you work with an application diagram:

18l .
:

The Application Diagram Viewer, is the combination of the Main canvas and the Palette view
The Main canvas contains the diagrams, the diagrams can be edited, and saved

The Palette view contains the controls that are available to work with the Main canvas.

The Outline view available as thumbnail or text view, to easily navigate the diagram on the Main
canvas.

5. The Properties view to show detailed property values of a selected node on the Main canvas

b=
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3 Creating a Source Call diagram

You will learn first, how to create a Source Call diagram that shows how subroutines, procedures and
external programs are connected to each other in a given application.

3.1 Starting the workbench

Please use Lab01 'Getting started with RSE' for instructions on:

1. How to start the workbench.

2. How to get connected to an IBM i server.

3. Which server to use and which User ID to use, for IBM supplied IBM i systems.

After you have created a connection, go ahead to the next section.

3.2 Creating an application diagram

There are two ways to create an application diagram:
1) Inthe Remote Systems LPEX editor, when editing source code.

If you are interested in analyzing one source member as you are working with it, then use this option.
2) In the Remote System Explorer, when you need to analyze multiple source members in one diagram.

Launching from the Remote System Explorer perspective allows multiple selections of select RSE
resources of the same type:

1) ILE RPG and ILE COBOL source members, IFS files and local files.

2) IFS folders. (All ILE RPG and ILE COBOL source files in the folder are included.)

3) Local folders. (All ILE RPG and ILE COBOL source files in the folder are included.)

4) Member filters.

5) Program and service program objects.

6) Object filters.

The Application diagram tool uses the program Verifier, which is the frontend of the IBM i1 ILE
compilers. The Verifier extracts the information needed for the diagram. If the Verifier fails because of
semantic or syntax errors, the Application Diagram can't be created. To create an Application Diagram,
you will need a source member that will compile error free with all the external references needed. This
means you need to setup the library list for the RSE job according to the program’s environment needs.
To accomplish this for this lab you need to add the application library WFLABXX to the library list of
the RSE job.

You will add another library to the connection's library list for these exercises.
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3.3 Changing the library list

Now the Remote System Explorer perspective is open, and you can add the library to the library list:

_ 1. Expand the Objects subsystem in the RSE view
_ 2. Rightclick on the Library list filter
_ 3. Select the Add Library List Entry action.

v B 1BM Demonstration Server
v &° Objects
As Work with libraries...
A7 Work with objects...

12

embers...

£3 = - -
@9 Jobs E8 Open in New Window

©? IFS Files
j Spooled & Refresh F5
o Cshells |
Change Current Library...
Change..
) Rename... F2
K Delete... Delete

4. Enter WFLABXX in the dialog. This time don't replace XX with your team number, use

WFLABXX
_ 5. Select to add the library to the Start of the library list
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6. Click the OK button.

E
() Acd Library List Entry

dehw::.my{ WHLASXX v & Beowse.

dion addanional lbrary
@ Start of list End of list

After library Before brary Replacing hbrary

-

ADOLIBLE LIBOWFLARXOX) POSITION(*FIRST)

3.4 Selecting source members and creating the diagram

In this exercise, you will work with multiple RPG source members to create an Application Diagram:

—

Expand the library list filter

2. Expand your team library RSELABXX library, XX being your team number
3. Expand the QWFSRC source file.

4. Select the ORDENTR member

5. Press the CTRL key to be able to select additional objects

6. While pressing the CTRL key, select member SLTCUSTR

Page 10 IBM Rational Developer for i Sandbox — RDi Lab 06 — Application Diagram Viewer



.

Right-click and select the Visualize Application Diagram action.
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#ARemo...

‘1% Navig 8 Pr-
& &)
» Jo DDSSRCZZ.*fie.pf
» W EMPMST.*file.pf-d
» W EVFEVENT.*fide.pf-
» &5 MSTDSP.*file dspf
» G5 MSTDSP2.*file.dsg
» W PRIMST *file.pf-dt
%o QCBLLESRC.*file.p
» o QCLSRC, *filepf-sr
» Jo QCMODSRC. *file.pf
» T QDOSSRC.*file.pf-
» T QLONGSRCPF,*file
» lo QRPGLESRC *file -
» Jo QRPGLESRCP " file.
[~ Jo QWESRC *fide.pf-s.
& ORDCOMIT1pg
| % ORDENTR.rpglel
6. ORDENTRFF.rpe

(g

.}‘mxn;

s

= i
Go To
Open With
Browse With
Refresh
Rename...
Delete..,
Copy
Movye...
Find String...
Verify
Compile
User Actions
Add Jo i Project...
Make Available Offline

Debug of Code Coverage (Service Entry)

Compare With

% PRTORDERR.1pc

% SLTCUSTR.rpgle

(2 Visualize Application Diagram
—

F2
Delete

>

Ctrl+Shift+C
>

% SLTPARTR.rpgle

% ZORDENTR.rpgle

% ZSLTCUSTR.rpgle
» W REFMST.*file.pf-dta

O Properties 3 | T Souece Prompter D Field Table

v

Prope.. Value

Adbeili COS

A progress bar shows that the diagram is being built:

. Building application diagram

@ Scanning resources

RSELABO1/QWFSRC(SLTCUSTR)

[CJ Always run in background

Run in Background {

Cancel

|| Details >>

IBM Rational Developer for i Sandbox — RDi Lab 06 — Application Diagram Viewer

Page 11



IBM Software

Once building completes, the application diagram opens in the main canvas with a
horizontal orientation:

Tip:

To continue working while the diagram is being built, click Run in
Background. It is useful when an application diagram takes a long time to
build.

The nodes for both source members are shown and you can easily see that three programs
outside of member ORDENTR are being called from this member.

The members are shown with functional zoom on, their internal call hierarchy is not shown to
avoid overloading the diagram with too many nodes. The main nodes however show how
many nodes they contain internally, ORDENTR contains twenty-one nodes and SLTCUSTR
contains 5 nodes.

From this initial diagram view you can see that programs QSNDDTAQ, SLTPARTR, and
SLTCUSTR are being called. The /copy member ORDMALIN is also shown.

3.5 Basic navigation in an application diagram

You will first exploit the navigational features of the Application Diagram viewer.
You are interested in more details of member ORDENTR, zoom into this individual member to look at
the internal calling hierarchy.
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Click the + inside the ORDENTR node to zoom into the member.
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5 ORDENTR

~

SLTCUSTR

» ROges

-

ORDMAIN

ot }

SLTPARTR
{i ORDENTR
71 nocdes

Source Member RSELABOS/OWFSRCIORDENTRY COhck on the "«" sign in the left cormer 0 I‘l:‘,.\."("i

- e
1

SLTCUSTR

4

QSNDDTAQ

You can now see the additional nodes for subroutines and procedures in this member and the

call relations they have.

Actually you might not see a lot since the main canvas is not big enough to see the entire
diagram. You can easily move the visible the part of the diagram by going to the Outline view.

In the Outline view click on the blue rectangle that represents the viewable area of the main

canvas.

Drag it down so the main entry point for member ORDENTR and several nodes are now

covered by the blue rectangle.
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4. Also hide the Palette view by clicking on the minimize button on top of the Palette view.

_—
"ORDINR Towrte LJ

Vo «

VA

wrive

A3 s

If you want to the get the Palette view back you can use the restore button to un-hide it.

*ORDENTR Outhre -
"
hos
SUTeA
¥ ONgOvm
{
Poocm “f
AN
ASE Ny o
-
- e T T
e
NS v = ASIv
i |
Rybwe Chfnes A DAY
* omoowr

Uiy

ONC unt

‘e
oSt LRy

If you still need more visible space for the diagram, you can maximize the Main canvas.
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‘ Note:
Double clicking on the Main canvas tab will restore the view to its

original size.

Note:
If you need a specific view that is hidden because of the maximized

Main canvas. You can use the fast view buttons on the sidebars of the

workbench to restore individual views. If you hover over a fast view
button yon see text that shows the view name.

Now that you have launched the application diagram, you are ready to work with it.
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4 Working with an application diagram

In this module, you will learn how to navigate within an application diagram by using the Outline view.

4.1 Navigating an application diagram using the Outline view

You have already used the Outline view to move the highlighted rectangle to view different parts of the
diagram, but there is more to the Outline view.

The default view for the Outline view is the Overview or Thumbnail view, this is the view you used in
the previous exercise. There is also a Text view available that shows the diagram content in a tree view.

__ 1. Ifthe Outline view is not visible, click the Qutline view button on the Fast view button area on
the right side of the workbench.
_ 2. Click the Outline button on the top of the Outline view, to show the Text view.

L T T S eV ey e—

Now you'll see a Tree view of all the elements shown on the Main canvas.
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_ 3. Expand the ORDENTR node in the tree view.

< < e® &
o= Outline L]

« I» Application Dagram
« (1, ORDENTR

€ *INZSR
£ AdaOrdHdr
+ AJeOrdLn

AddOrder

£ ChgOrder
ClrEsror
CrnOecler
EndPgm
GETORDNSR
ORDENTR
Process

£ RgeCust

£ RgsPart

£ ShCust
L SitPant
£ UpaCust
< UpdStock
s VRYCUST
& ViyPart
 ViyQuy
£ WrtDta
ORDMAIN
SLTCUSTR
QSNDDTAQ
SLTCUSTR
SLTPARTR

ay
a\
.
ak

You will notice that different icons represent different types of callable entities:

(1) The ORDENTR entry point of the program
(2) Subroutines

(3) Procedures

(4) Program objects

(5) Source members

You can use the Tree view to navigate to a specific node in the diagram by selecting it.
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_ 4. Select the RqsPart subroutine in the tree view.

ORDENTR Ovrine

e '

s —]

ASICe s

You notice that the RqsPart node in the diagram is now in focus. The connection line colors

going in and out of this subroutine have changed.

e Red lines indicating an invocation of RqsPart from other resources in the source member

e Green lines indicating EXSR/CALLS from RqsPart to other subroutines, procedure, or
programs.

If you want to learn more details about a connection you can hover over it, to get more

information

5. Click on node SLTCUST in the diagram to give it focus.
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6.  Move the cursor over the connection that goes to program object SLTCUSTR. Just hover over it
and a text will appear with more details about this specific connection.

"ORDENTR

The tooltip for this connection shows the names of caller and called objects. The caller is a
subroutine and the called object is the program SLTCUSTR.

This is great to get a fast overview, but how about looking at the source directly from the
Application diagram? Accessing source is your next task.

Tip:
Sometimes the diagram has many nodes. To easily locate the starting

point of the diagram, right click the blank space on the diagram and
select Find Main Entry Point.

f i

INZSR ¥ CmtOrder AcdOraLin

¥ Raspn ¥ arrror %

file ’
¥ ORDENTR cir

- Setext '

EndPgm Asrange All

k RgsCust Coflapse
Expand
t . Edit Source
SitCust

& &

Find Main Entry Point

Properties. bRC-NEF:
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4.2 Opening a source file from an application diagram

Most likely you will want to get some more detailed information about the source member you are
navigating through. The call hierarchy is a nice high-level overview, but eventually you have to see the
source containing the detail information.

The application diagram allows you to browse/edit source for:
« Subroutine and procedure nodes
« Incoming and outgoing connections.

1. Double click on the RqsCust subroutine node, to invoke the source editor.
g ACAOrger
SitPan
: *INZSR LS CmtOrcier ’ AddOrvalin
k RosPat L ClrError " A0 aHd
* ORDENTF
EndPgm
x
1 RqsCust
Subroutine RgsCust of RSELABOS /QWFSRCIORDENTR)
ALY
‘e b
VFYCUST GETORDNER

The source editor opens, and the cursor is positioned to the BEGSR statement of subroutine
RqsCust.
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7 ORDENTRRPGLE
Line 118 Column 1 Replace
l. LLLCLENOIFactorlissererslpcode(E)sFactorZ2esssresBesultersrsrnrlens
( SELECT
( WHEN DspPnl » $Pancll
( EXSR RgsCust
WHEN DspPnl » $Panel2
EXSR RgsPart
( ENDSL
ENDOO
( EXSR EndPgm
B SR RqgsCust BEGSR
( WRITI FKEY
( EXFMT PROMPT
( EVAL *IN79 «*ON
EXSR ClrError

You can now work with the source or switch back to the application diagram, to navigate through
other parts of the member.

5] e s cant b apayc. Ti p E
The diagram will not stay synchronized automatically with any changes
that you make in the Remote Systems LPEX editor. To view changes
made to the source, close and re-open the application diagram.

. Tip
To open the source editor in browse mode, instead of double clicking
use right click and then select the Browse Source action.

To open the source editor and position the cursor to the line where a call happens in the member,
you can use the connections.

2. Click on the Application Diagram tab to give it focus
3. Move the cursor on top of the connection going into RqsCust, the one that is colored red. As the
cursor gets directly over the connection it will change color and display a tooltip text.

Page 22 IBM Rational Developer for i Sandbox — RDi Lab 06 — Application Diagram Viewer



IBM Software

4. Stop moving the cursor and double click on the connection, to bring the source editor into focus.

ORDENTR ’
SUICUSTR .
; Adnder
4 QINODIAQ
St
4 ¢ 3
N CrmQncer AKrdn
B 5 ¥
R Qv Aot
* oapenm
. g e
i ) Botyre
o procedure CRDENTR of RSELASOR QWP SRCIORDENTR
%
Butrowtine RasCust of RSELABM/QWTSRCIORDENTR)
) S
‘e s
VYOSt GETORDNER

The source editor gets focus and the cursor is positioned at the line containing the EXSR
RqsCust statement that invokes this subroutine.

# ORDENTRRAGLE & |

Line 103 Column 1 Replace
l. L CLONDTIFactor ] ssssassOpcode(E) sFactor2essssssResul tessssrssLens+DeliloEq. ...

* MATNLINE

* Until the user chooses to exit

Don) Exit = $True
Display the panel to user
SELECT
. prompt for a custoeer
£ Wbl nl_#l)nl gnumlx
C EXSR RgsCust
TW LR - V"' ' it DTt

WHEN DspPnl « $Panel2
( EXSR RgsPart
( ENDSL
( ENDDO

EXSR EndPgm

Now do the same for an outgoing connection.

_ 5. Click on the Application Diagram tab to give it focus
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10

11

Move the cursor on top of the connection going out of RqsCust, the one that is colored green,
and invokes VFYCUST. As the cursor gets directly over the connection it will change color and
display a tooltip text.

Stop moving the cursor and double click on the connection, to bring the source editor into focus.

} }
INZSE " CmOnder ™ AdalraLn

i '
* RgsPant ™ Cutro AdIOndHar

b ORDENTR

{ ™ EndPgm
* RgsCuit :

/‘j st
Subroutine RgsCust of RSELABOS/ QWFSRLIORDENTR ks

te
a3 | CETORDNER
Subproceduse VIYCUST of RSELABOB/OWTSRCIORDENTRY

Again the cursor will be positioned at the statement containing the selected invocation.

This works great for connections inside of the source member that invoke subroutines or
procedures located in the same source, but how about calls to outside programs? Application
Diagram doesn't support direct drill down to outside members, but remember you selected two
members to be shown in this diagram.

Now you will work with the second member.

Click on the Application Diagram tab to give it focus
Click the SItCust subroutine node. It actually has a connection to program SLTCUSTR outside
of this member.

To see the source of program SLTCUSTR you need to navigate to the source member, the
second member you selected to be added to this application diagram.

To locate it on the Main canvas, move up to the top of the diagram, or use the outline view to
navigate there.
Click on the + inside the node of SLTCUSTR to expand it and see its detailed call hierarchy.

Page 24
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Tip:
Be sure to select the source member, and not the program object the
connection points to

You can now work with this member the same way you worked with member ORDENTR.

_12. To open the source editor, double click node BldSfl.

*ORDENTR

The source editor opens member SLTCUSTR at the BEGSR statement for subroutine BldSfl.
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# SLTCUSTRRAGLE
Line 69 Column 1 Replace
'....(l\’!lwlhzrtorl»nnnur.-:udv(l)-‘.lctor}'-'-onRr'.uEtwnvn-lcrnU~Hilo‘:m...
F CSR  8ldsfl BEGSR
stm J

You can see that drilling down through multiple source members is pretty easy by selecting them
up front as you create a diagram.

4.3 Working with the Properties view

You haven't really looked at the properties view associated with an application diagram; let's have a look
what it provides.

1. Inthe application diagram, navigate to the RqsCust subroutine
. Click the RqsCust node, to select it.
3.  Have alook at the Properties view at the bottom left of the workbench, underneath the RSE
view (you may want to use Window / Reset Perspective from top menu to reset your view)
4. Ifitis too small, resize it by moving the cursor to the borders of the upper border of the view
until it shows a double arrow, then drag the border up.

'y 1\ '
' RgsPart ' Chrron * AddOrdHd
*

Caity Type SMROUTING ORDENTR :

* RasCust

e

The Properties view contains three pages:
(1) General
(2) Calls
(3) Called by
The General page has information on the type of language and location in the member.

5. Click the Calls tab, to see detailed information about the programs, procedure, or subroutines
called from RqsCust.
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¥ RgsCust

Name
Calls SitCust

CieError

EndPgm

EnaPgm
VFYCUST

Location

ORDENTR
ORDENTR
ORDENTR
ORDENTR
ORDENTR

-  Start line
149
10
592
592
656

End line
163
176
601
601
691

Type Language
SUBROUTL.  RPG
SUBROUTL. RPG
SUBROUTL. RPG
SUBROUTL.  RPG
PROCEDURE  RPG

IBM Software

You can see the details of the four subroutines and one procedure being invoked in subroutine
RgsCust. As in all tables in the workbench you can sort by clicking the columns headings. The
Properties view allows to invoke the source editor directly from the Calls and Called by pages.

7. Select the Browse source action.

6.  On the Calls page, right click procedure VFYCUST

2 Propertics o4 |\, Re

* RgsCust
General Name Location ~  Start line End line Type Language
Calls SitCust ORDENTR 149 163 SUBROUTL. RPG
Calied by CuErroe ORDENTR 170 176 SUBROUTL. RPG
EndPgm ORDENTR 592 601 SUBROUTL. RPG
EndPom. . ORDENTR 592 601 SUBROUTL. RPG
| VFYCUST ORDENTR 656 o OCEDURE RPG
Browse Source

If the source member is already open for edit you will get a warning message:
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_ 8. Click the OK button and the source editor is brought in focus.

7 ORDENTRRPGLE

Line 656 Column 1 Replace Browse
l, c..PNomEssssssssses B, ... . ........ Keywordsssssststststrtrtrttstsrsrates

housID = $Harehouse

SR ENDSR

B vvivcust ey

/free

Customer
CADOR]
CADOR2

Notice, the source editor is still open in edit mode (Replace).
In the properties view, the Called by page shows all invocations of subroutine RqsCust.

9.  Back in the Properties view of the application diagram, click the Called by tab.

Properties
1 RgsCust
General Name Location ~  Start line End line Type Language
Cailis ORDENTR ORDENTR 1 117 PROCEDURE  RPG
Called by

There are also properties for connections available.

10. In the Application Diagram, click on the connection from subroutine RqsCust to procedure

¥ oroeNTR
" EndPgm
Propent I
Propertes L RgsCust
& ‘
General 77 ACum L $ R
'e o ShCust
. v Suteoutne ResCust of RSELABOR/QWFSRCIORDENTR
Type Irecar |
Subpeocecss YIYOUST of RSELABWOWSSECIORDENTRS
Sotpe bvckes s - VIYCUST
» Line

The starting and ending nodes for this connection are shown in the Properties view. Notice the
connection type of Invokes.
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__11.  Click on the connection from SItCust to the program SLTCUSTR.

{

EndPgm -
SLTCUSTR

St
e Line: 151 i-k -
S

ShtCust |-

‘
OSNNNTAN

The connection type has changed to Program Call.

You can see that navigation through an application diagram and its related source members is
fairly easy.

Next let's look at a Program Structure diagram and how it can help you working with your ILE
objects.

Before you continue close all editors.

12.  Right click on one of the tabs in the editor area, it doesn't matter whether it is a source editor or
Application diagram tab.
_13.  Select the Close all action.

. RDiLabs - Remote System Explorer - RemoteSystemaTempFies/COMMON T FRANKENLCOM/QSYS LIB/RSELABOT LIB/QWFSRC FILE/ORDENTREPGLE - 1IBM Rationa

Fle Edit Source Compile(G) Navigate Search Project Run Window Help
O~ G U'U‘q.'y‘..' iy v v | w v? . -
& Remcte Systems 01 | %o Te b
b Linme 151 oIG
PAYROLLG. " medle ~ '....(‘.(}M!'.‘n((c’l Close Others HeoRes
0 COMPARE.*fle pf-src ".": Close Tabs to the Left
&) DOSSRCSV.*le.saA when *IN)
© DOSSRCZZ.*file pf -src Exs 5;_
I EMPMST, “file.pf-dta Other:
T EVFEVENT*flepl-cdta CALLP VFYCUST
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5 Creating a program structure diagram

The Program Structure diagram shows binding relations between IBM i program objects. Instead of
source members you select program objects to be added to the diagram.

Let's have a look at the WebFacing runtime and its binding relations.

5.1 Creating a filter in RSE

The WebFacing runtime program objects reside in library QSYS, in order to work with the right subset
of objects you will first create an object filter in RSE. All WebFacing objects start with the prefix QQF,
you will build a filter that subsets the QSYS objects for this prefix.

1.  Inthe RSE view, expand the Work with objects filter.
2. Inthe New Filter dialog, specify Library: QSYS, Object: QQF*.
3. Click the Next button.

v & New Connection

fa BMii... )
Q) Local © New Object Filter 0 X
G Lecad
v E& 18BM Demonstration Server Object Filter -)
v @ Objects Create 2 new IBM i object filter -
As Work with libraries...
@.’. 5 Work with objects...
Ay Library: d = -
A0 Work with members... =
=0 Libeary list Object: qqf1 . Brogyse...
5" User libraries
8 Commands Object type: v A Browge...
&8 Jobs Object attribute: | * v A
¥ IFS Files
% Spooled Files More Types>>
[y Qshells
? ' l Next > l Cancel

4.  Enter Filter name: QQF, to give the filter a meaningful name.
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5. Click the Finish button.

© New Object Filter O X
Object Filter - 1
Name the new filter
=) |

Filters are saved for easy re-use. Specify a unique name for this filter. This name will appear

in the Remote Sy jew, and will be expandable.
Filter name: iIQQH ]

[4] Only create filter in this connection

cuticulal.CN-IBM Demonstration Server-com.ibm.etools.iseries.subs

@ < Back Next > || Cancel

5.2 Creating the diagram

In the RSE view navigate down to the new QQF filter.

1.  Expandit
. Click the first program object to select it.
3. Hold the SHIFT button and click the last program object in the filter.
This selects all program objects in this filter.
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4. Right click and select the Visualize Application Diagram action.

v & New Connection
fs BMi...
B Local...

G Local
v B 18BM Demonstration Server

v & Objects
A3 Work with libraries...
v A2 Work with objects...

] Filter created successfully. Expand this again to create another

25 Work with members...
By Library list
B© User libraries
§o QQF
; QQFTEMP.*lib.test

24 QQFENDSVR.*pgm.cle

[ QQFGEDOBI"pgm.cle  [0°T° >
(4 QQFINVOKER."pgm.cl Show in Table
(2 QQFSPWSVR.*pgm.cle Monitor
(2 QQFSTRSVR."pgm.cle —
(2 QQFVTSVR.*pgm.cle Refresh F5
2 QQFWFSVR."pgm.cle
[, QQFENV."srvpgm.cle Rename... F2
4 QQFSYUTILS.*srvpgm. 3 |Delete... Delete
& UTILS." .cl

8 Cor:?nﬁ R JUser Actions >

@9 Jobs Add To i Project...

4

i ‘:5 F':’; . Make Available Offline

%3 Spooled Files )

g Q‘:hells Debug or Code Coverage (Service Entry) >

Debug (Prompt) >

In the Program Structure diagram:
5. Navigate to the QQFSYUTILS service program and click it.

Sl
S QQPWSW WO
we .w‘— "] -
VEQUENT 3 — QoFums
\ FOONS 2% -
WO, S QLGCASE

QU SPWSE
WESPWSR

\ — POTSYSE

\

\
QOFVISVR
WEVTA LN \ 5

> IS = - QPOSSRVI
d -2 s
QOFGETO8 = -
- -
WE O
- SYEIEN
= QSYEIM

You notice that program objects and service programs have different icons.
QQFSYUTILS is a service program. You can get more information about the selected
object by using the Properties view.
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It is easy to see that two programs bind this service program and it itself binds three
service programs. In this busy diagram the different coloring of connections comes in
handy. It makes it a lot easier to see incoming and outgoing connections of the selected node.

5.3 Working with the diagram

Notice that some programs and service programs have dots ... behind the module names. This indicates
they contain multiple modules.

_ 1. Click the + sign in the QQFWFSVR program to expand to all modules.
_ 2. Click the + sign in the QQFSYUTILS service program to expand to all modules.

........

Now all modules in these programs are visible.

5.4 Working with properties

The Properties view shows more details:

_ 1. Inthe diagram, select program QQFWFSVR.
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_ 2. Check out the Properties view for detailed info.

WITNDSVE

Properte
QQFWFSVR

Geaernt

Mocues

Uses Service rogram  Tpe

QOQFINVOKER

WFINVOKE
-— QOQFUTHS
WFCOMMS
You get name, type, debug, and date information.
_ 3. Click the Modules tab to display the modules page.
:Q(‘I:;\—‘I\V)l
e - e QQFWISVR
[—:’:‘“‘i WEFCLIENT .
(1= ey - '.\'II'-“.Iff- U QQFINVOKER |

WFINVOKE

WFSSSION & - QQFUTILS

WEVIMGR
WFVIMGR WHCOMMS.

Now the details for all modules in QQFWFSVR are displayed.

4.  Click the Use Service Program tab, to display details of service programs this program uses.

RUSVE

QQrwWrsVR

[om—

Moouin g2
 [roeprmrer—

QQFINVOKER
WFINVOKE

You can also get module detail information by selecting a module in the diagram:
5.  Inthe diagram, in QQFWFSVR, click the WFDATA module.

- | WITNIBVR
Pogentes l
WIDATA
gl A QQFWFSVR
Procecun Ly QRR0ss] —WECLIENT r x
hit = WEDATA = QOFINVOKER
Aty ( . TWITECHYP »
ot M WESERVER WFINVOKI
WFSSSION a QoRUTIS
waca s OWL/11 1031 At acy :
” sl WFCOMMS
b Inpe N

The module details get displayed in the Properties view.
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6. Inthe Properties view, click the Procedures tab to display a list of procedures used in this

module.
WFENIOVR
WFDATA
" e QQFWESVR
po— e | comeriacisincon WFCLIENT
WFDATA Y QQFINVOKER
WFDECRYP
WHINVOKE
WESERVER NS y
WEFSSSION .- QQFUTILS

WEVIMGR
' ' WHCOMMS

These are the detailed program information, for service programs similar information is

available.

Let's look at the Exported Procedure view for service program QQFUTILS.

7.  Inthe diagram click the QQFUTILS service program to select it.
8. Inthe Properties view, click the Exported Procedures tab.

L QOIUTHS

M iy
oty Somvcr Pogrem
i
[l-—ww

QOFWFSVR

QOQFINVOKER
WL RYY
NVOKE 2

. .

-
it i‘ 1

Wi

-k ()

- CXHUTRS

IMMS Servae P

This shows the exported procedures for this service program.

o Sometimes, information in the Properties view is not available because not
all resources were selected when the application diagram was launched.
To view the missing information, you must close the diagram, select the
missing resources in the Remote Systems view, and re-open the diagram.
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5.5 Working with diagram views

The default for application diagrams is to show both views:
1. Source Call Diagram
2. Program structure diagram

You can change views and select to view just one of these views, by right clicking on the Main canvas of
the diagram and select the Switch views action.

You already created a default diagram showing both views when you went through the first Lab. The
Application diagram contained selected Source members and program objects that are called from the
source members. The nodes representing the called programs were shown with non-solid border lines,
indicating that the detail information for these programs is not available. You could add detail program
information to these diagrams by selecting the source members and the program objects to be included
in the diagram. This gives you more detailed information about your application.

If you want to try this, go through the following steps or skip to the next module, Changing application
diagrams.

1.  Expand the Library list filter

2. Expand the WFLABXX library. (if you have disconnected from the host system since the start
of this Lab, you will need to addlible WFLABXX again) (replace ‘XX’ with your team number)

3 Expand the QWFSRC source file.

4 Select the ORDENTR member

5 Press the CTRL Kkey to be able to select additional objects

6.  While pressing the CTRL Kkey, select member SLTCUSTR

7 Scroll up in library WFLABXX to the section that shows program objects,

8 While pressing the CTRL key, select program object SLTCUSTR

9 While pressing the CTRL key, select program object SLTPARTR
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_10. Right-click and select the Visualize Application Diagram action.

* B WFLABXX *lib test-use

& CLRMSG *pgm.cip -
o DSPMSG *pomucip

+ 5 GUIDESL.'pgmrpgle
% ORDCOMIT.*pomupghe
& ORDENTR *pgmupgle
5 ORDENTRCAL*pomspgle
5 ORDENTRCL*pgmclie
4 ORDENTRPAR. *pgmupgle
i PAYROLL*pgm.cblie
& PRTINV.*pomcip
i PRTORDERR *pgmurpgle
& SLTQUSTR *pomspgle
4 SLTPARTR *pom.pgle
5 SLTPARTRF *pgmupgie

¥ SLTPARTROL *pomuspgle
bbb b d AN VALY AL L L LL L L 1

P FRODINVITREMOI S e e o -
T PRODSHOW.*fil GoTo

L1 PRODUCTF.*file :
) PRODUCTLL*fiN M\:"m
& PRTORDERP il Browse

Jo QUBLLESRC.*file £) Refresh
o QALSRCilepfs 1 Rename.
% QCLSRCO00L*S % Delete..
% QDOSSRC*files & Copy
I QDDSSRCCEL*! +f Move
-l QDOSSRCPAfile o
T QDDSSROWEB.* .
1o QDOSSROOLY oL Senvikes
% QOOSSRo002+r " Find String..
Jo QDOSSROCO3.  Verify
Jo QMNUSRC*tile]  Compile
o QMNUSRO00LY  User Actions
20 QPNLSRC *tilep Add To i Project..
% QPNLSRCP-"file. s pie Available Offtine
Jo QPNLSRO00L.*f) _
b QPNLSROCO2.*fi or s
« Uo QRPGLESRCtiy  Compare With
€, ORDCOMITr| 3= Visualize Application Diagram
£ ORDENTRpglE m

&, ORDMAIN.rpgle
&, PRTORDERRrpgle
8, SLTCUSTR.pgle

. 8 SLTPARTR1Dale
The diagram will show:
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[} Remote System Explorer - The appiication disgram for SLTCUSTR asd other rescurces. - IRM Rational Developer for |
Fle Eot Dagram Nawgate Search Propect Data Run Window Melp
- 2 - @ -e @ [ v @ Actvity Omher Activity » = Cr0O-q

Segoe UL w9 Bl AH s~ - .- - | 100% -

A Remote Systems 1 | SLTCUSTR

ORDENTR

Properties R

i SLTCUSTR

General Name SLTCUST!
Mockles
Uses Service Progran|

The program nodes SLTCUSTR and SLTPARTR now have solid border lines since the
application diagram tool was able to retrieve the detail information from the system. For any
object that is selected at diagram creation the Application Diagram will gather the detailed
information and show the nodes with solid border lines. On the other hand, the program object
QSNDDTAQ is still unknown to the diagram and its node is shown with non-solid border lines.

The Properties view will show the detail information for a selected object in the diagram, as it
could be gathered at the diagram creation time.

If you only want to show the Source Call diagram:
__11.  Right click the Main canvas
_ 12, Select the Switch view action
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_13.  Select the Source Call Diagram action.

15 SLTCUSTR

C

SLTCUSTR

3 nodes

File L4

Select ’ -
QSNDDTAQ
Change Layout.

Arrange Al

View ’

Loaoom | strcustr

Collapse All QTCU
| Expand All |

Find Main Entry Point

Preferences ’

Properties. SLTPARTR

Switch View »

Source Call Diagram
v A

C

ORDMAIN

Now you will see the Source call diagram only:

L» *SLTCUSTR
C

SLTCUSTR

S nOdes

ORDENTR
25 nodes

r ORDMAIN

You have worked with different diagram views and you have seen the importance of selecting
resources to get access to their property values, for both source members and program
objects.

You also switched views to only select one type of diagram to be shown.
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6 Changing application diagrams

In addition to making navigation through an application easier, application diagrams can also help you
document applications. To add documentation to a diagram you can annotate it and then save it with the
annotation.

In this module, you will add documentation to the application diagram with notes and text. Then, you
will change text properties to improve readability.

You will now add some information to the SLTPARTR Source call diagram.

6.1 Annotating an application diagram

First, close all editors then create a new application diagram for member SLTPARTR:
_ 1. Right click one of the tabs in the editor area.
2. Select the Close all action.

b aSLTC ==

ORDMAIN

_ 3. Inthe RSE view select your RSELABxx (where xx = your team number) then the SLTPARTR
member in source file QWFSRC
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_ 4. Select the Visualize Application Diagram action.

> UH QUUSSRC ™ hle.pt-src

> b QLONGSRCPF *file.pf-src
> o QRPGLESRC. *file.pf-src
> [y QRPGLESRCP.*file.pf-sr¢

(v [ QWFSRC.*file.pf-src )
3 ORDCOMIT.rpgle

G, ORDENTR.rpgle
G ORDENTRFF.rpgle

G, PRTORDERR.rpgle

SLTCUSTR.rpgle
G, SLTPARTR.rpgle
3y ZORDENTR.rp¢ Go To
€, ZSLTCUSTR.rpg
» [ REFMST filepf-dt 0P With
> [ RSNMST.*filepf-¢  Browse With
> [l TESTPF."file.pf-src &) Refresh
B MYCOMPILE."cme
> =4 WFLABXX."libtest-ust 11 Rename...
> = QGPL’lib.prod-ust 3¢  Delete...
:K = Q.TEM?.‘Inb‘test-uﬂ @ Copy
> m> Userlibraries
> @b QQF «» Move...
caink=binn - ®’ Find String...
Properties 53 | (3. Remote Scratchp Verify
Compile
Property Value )
Attribute SRC Compile (Prompt)
Name SLTPAI User Actions
Number of children 0 Add To i Project...
Source RSELA ) )
Text Select Make Available Offline
Type RPGLE Debug or Code Coverage (Service Entry)

Compare With

R

IBM Software

>

>

>

F5

F2
Delete ¥
]
r
> i

>

>

>

>

>
Alt+Enter

rasta an annliratinn dianram fram tha
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_ 5. Right-click the SLTPARTR node and select the Add Note. Action.

»

fINZSR
™ Process
™ o B e
SLTPAI ¢ Add Note EndPgm ClosePan
File )
Edit Source
Browse Source
Properies

This action creates an attached note to the node.

6.  In the text area, enter Main Entry Point
7. Press Crtl + Enter to add a new line.
8. Add some more text.

# aparn { EndPgm as
{ Blash
~ 9. Click the diagram canvas to finish editing the note.

k *INZSR

# sureaRtR 0 Enapgm

k Badsh

To work with this note:

_10. Select it and resize it, by moving the cursor over the border until the cursor switches to a double
headed arrow indicates that you can resize it

__11.  Select it and move it when you see the cursor switch to four arrows
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12.  Double click it to edit the text.

Mais gatry pont for

i
TS

Parts Selamon (Yo
DS SENCD0N rojram

| VY

™ Process
Y mam e
SLTPARTR EndPgm

{
Blas

To add a note to a connection:
_13.  Right-click the connection line joining the Process and EndPgm nodes.
_14.  Select the Add Note action. This creates an attached note to the connection.

Nan ary point for
Parts Secton program - "INZSR
] DTO(é'n}
4. | Add Note l
¥ suparr File 3
Edit Source
K st Browse Source
Properties.. \

15, Type Connection Line into the note
__16.  Click on the canvas to finish editing the note.

Main eatry posre for
£ o
At cmon B ) SINZSR e
L Process
3
* SLTPARTR * EndPgm
B giosn

You can attach a note to multiple resources. Attach this note to another connection:

IBM Rational Developer for i Sandbox — RDi Lab 06 — Application Diagram Viewer Page 43



IBM Software

__17.  Select the note and the down arrow on this note.
Main entry point for
! 3 = 5
Farts Selechon program SR l S i
| !
- Proce
* SLTPARTR k EngPgm i ClosePan
; 8lasn
_18.  Drag the down arrow to the connection that connects the SLTPARTR node and EndPgm node.
Mawn entry point for
Parts Selection grogram ‘ *INZSR e =
" Process D
*  sLTPARTR :] i EndPgm
i Basr
=] T == T|p:

connection.

You can change the connection and move it around by moving your cursor
on top of it and when the cursor icon changes, click it and move the
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Next you will create a stand-alone note (a note that is not attached to any node or connection.)

1. Ifthe Palette view on the right side of the Main canvas is hidden, click the drop-down arrow

on the top right.

% *SLTPARTR

SLTPARTR

2. In the Palette menu, click Note.

Diagram Tool
Click the Note object to select it

4

5

6.  Enter some text in the note.

7 Click on the diagram canvas to finish editing the note.

Click anywhere on the diagram’s canvas. to add a note at this position.

3. Click the drop-down arrow to expand the controls list in the Palette view for the Application

1% *SLTPARTR

C

SLTPARTR

L

OpenPart

r
{ Stand-alose note for genenc Sexd for thy appication

; !

ReadPan

> Palette

—

= Qutline

Text
Note Attachment

yo- o

-

e mane o

A stand-alone note is created. A stand-alone note is not connected to any object within the

diagram.
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6.3 Creating text

Next you will create stand-alone text. Text is a little different from a note, it has a transparent background,
whereas you can set the background color of notes.

__ 1. In the Palette view, click the drop-down arrow on Notes icon.
_ 2. Click the Text object to select it
_ 3. Click anywhere on the diagram’s canvas and enter some text into the Entry field.
1 *SLTPARTR i1 | " O | GE Outline &2
* o Palette | ¢
B SLTPARTR S
. * 1] 4 Notﬂ
fThis is some text _ Text
I, Note Attachment
{ OpenPart Stand-alone note for generic text for this application |

6.4 Changing properties for objects in diagrams

To change the properties for the objects in the diagram:
__ 1. Right click on the blank canvas, outside of the member rectangle.
_ 2. Click the Properties action.

5 *SLTPARTR

N File ’
Select ’

Change Layout.

b Amange All
OpenPart

View ¢
* Zoom ’

Collapse All
ReadPart Expand All
Find Main Entry Point
Preferences »

Propenies
Concechon Line

Switch View »

The Properties view opens.
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_ 3. To select a different color for the connection lines, click on the paintbrush button.

SLTPARTR

£

OpenPart

= Application Diagram Appearance ¥

{ FYIFARFY

oL |
ReadPart

=

1

Defauit

Connection Line
Customn -

<{ *INZSR

f

b Process. =

o T e Note:

Changes made in the Properties view only affect the current application
diagram. However, you can change those settings in the workbench
Preferences dialog box to affect all diagrams.

You have added attached and stand-alone notes and texts and changed the look and feel of
the application diagram.

A= s Important!
To keep the notes and the text added to a diagram, you must explicitly
save the application diagram. The module, "Saving an application
diagram”, describes the steps to save your diagram.
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6.5 Changing an application diagram’s layout

In this module, you will change the layout of the diagram,
To change the layout of the SItPartR application diagram:

__ 1. Right-click on a blank area on the Main canvas, outside of the member rectangle
_ 2. Click Change Layout action.

1M *SLTPARTR
File 4
£ Select » SLTPARTR
Change Layout.
Arange AT
{ View ’
open % Zoom 4

The Change Layout dialog box opens.

The options for Line Style are Oblique and Rectilinear. Oblique uses diagonal lines to connect
nodes, while Rectilinear uses only horizontal and vertical lines.

Switch the Line Style to Rectilinear.

4. Click the OK button.

W

(3 Change Layoun S5

Line style: |Rectibheeas v
Obhique

Onentation: Rectilinear |

Se1 as preferences

You will see that the layout of the diagram has changed.
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- ¥ INZSR

!

"8 Process.

[
______ |
¥ amam = —E EndPgm * K

—

~ ClosePart

“*"t BldSfl

To format the diagram from top to bottom of the screen.
_ 5. Right click the Canvas and select the Change Layout action.
6. Select Vertical from the Orientation list.
7.  Click the OK button to finish.

 —

—

(2 Change Layout ==

Line style: Rectiinear A

Onentation: Vertical -

Se1 as préferences

Main entry point fo

Parts Selection progran

* sitParTR

71

l |
t' *INZSR {;

“.Process t BldSfl

[ Y
Source Member RSELABOS/QWFSRC(SLTPARTR). Click on the *-* sign in the left comne|
—Tmargm

f

" ClosePart
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Depending on your personal preferences you can set the default options in the Change Layout
dialog.

Tip:
To set the current settings as the default layout style, check the Set as
preferences check box.

The Preferences action on the Canvas context menu allows to specify your preferences when
working with Application Diagrams.
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_ 8. Right-click on a blank area in the canvas and click Preferences > Application Diagram.

» *SLTPARTR = |
L

File

¢ Select
Change Layout
Asrange All
View
+ Zoom
Collapse All
Expand All

Find Main Entry Point |
Preferences » Application Diagram...

Properties.

¢ SLTPARTR

jection Lin¢

Colors and Fonts.

Switch View * |

Here is the Application Diagram Preference dialog:

(3 Preferences
Application Diagram

" oY
Application Diagram v vy

Speaty settings for application diagrams.

Defauit view: Al v

Layout

Lime styfe:

Ooligue v
Orientation:

Honzontal -

v Lay out the diagram automaticaly

Restore Detaults | | Apply

oK Cancel

Here is the Color and Fonts Preference dialog:
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) Preferences SRECH %)
Colors and Fonts Colors and Fonts

Colors and Fonts (7 = any character, * » any string):

a Agile Planning
[- & Application Diagram ]
s Application Diagram Fomt
9] Incoming line highlight color
o Qutgeing line highlight color

a Basic
o C/Ces
o CORN

«

Description

Preview
No preview available.

Restore Defaults Apply

(s L OK | Cancel

5] e e cant b dapaes Ti p:
To decrease the time it takes to build an application when you open an
application diagram, clear the Lay out the diagram automatically
check box. However, the resulting diagram may have a messy format.

You have changed the layout structure of the currently open application diagram and changed
default preferences for the application diagram viewer.
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7 Storing an application diagram for future use

You can save an application diagram in different formats:

1. As a diagram for further re-use.

2. As a text file, that can be searched or copied.

3. As an image file, to be shared with others or to be embedded in a document.

If you apply any changes to a diagram or a add comments in the diagram you will have to save the
diagram to preserve these changes. When you create a new diagram none of your changes will be

reflected, the diagram is created from scratch.

First you will save the diagram for further reuse.

7.1 Saving an application diagram for re-use

To save your notes and text that you added in the previous steps you will save the diagram to be able to
open it again with the changes available.

1.  Select the SLTPARTR tab to work with the SLTPARTR diagram.

S ASLTPARTR

SLTPARTR

f

OpenPart

ReadPart

You will save this diagram as a workspace file, so that you can work with it again later. First,
create a project for it where it will be stored.
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2. Click File > New > Project.

'. RDiLabs - Remote System Explorer - The application diagram for QQFENDSVR and other resources. - IBM Rational Deve
Edit Diagram Navigate Search Project Run Window Help

Areshiten >
Open File-.. = |BMiLibrary
[, Open Projects from File System... E§ I1BMiSource Physical File
Close Ctrl+W 0% IBMiSource Member
Close All Ctrl+Shift+W 7 IBM i Message File
Cove cules  UF 1BMiDats Queue
& SaveAs.. C IBMiData Area
Save All Ctrl+Shift+S [ Example...
st [ Other.. CtrieN

The New Project dialog box opens.
Under General, select Project (note you can type General in the filter)
4. Click the Next button.

W

© New Project (] X

Select a wizard —>
Create a new project resource [

Wizards:

type filter text

% Data Design Project N
23 Java Project
# Java Project from Existing Ant Buildfile
L Plug-in Project
= General

wEaceted Project

> ([ Eclipse Modeling Framework
> = BB v

[C] Show All Wizards.

@ < Back Finish Cancel

5. Inthe Project name field, type appdiag
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6. Click the Finish button.

© New Project (] X
Project |
Create a new project resource. { y
="
Project name:u appdiad ] ]
| —
[ Use default location
C:\Users\Administrator\IBM\rationalsdp\RDiLabs\appdiag Browse...
default
Working sets
[C] Add project to working sets New...
Select...
- .
@ < Back Net> || Finsh ||  Cancel

You just created a new basic project to your work. The default location of your new project is
the workspace directory that you specified in the first module of this lab when you started the
workbench.

To save the application diagram as a workspace file.
7. Click File > Save As.

&) RDiLabs - Remote System Explorer - The application diagram for QQFEND
@ Edit Diagram Navigate Search Project Run Window Help

New Alt+Shift+N >
Open File...

(", Open Projects from File System... 4
Close Ctrl+W E
Close All Ctrl+Shift+ W
Save Ctrl+S

la  SaveAs
Save All Ctrl+Shift+S
Revert

The Save As dialog box opens.
8. Select the appdiag folder
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9. Click the OK button.

© savens o X

Save As

Save file to another location.

Enter or select the parent folder:

[ appdiag

= appdiag
> RemoteSystemsTempFiles

File name: [ ApplicationModel.appmd|_diagram

@ ok D conce

The diagram is saved in the appdiag project that you created for that purpose.
To re-open the application diagram, add the project explorer view to the perspective.
~10.  On the workbench menu click Window
__11.  Click Show view
12.  Click other...

New Window fo 2| I L T IREIR A CRER
Editor >
Appearance >

P Ly |
> L Commandslog F
Perspective > ©] Errorlog Alt+Shift+Q, L
Navigation > s Object Table

[C] Properties
R ) 48 Remote System Details

28 Remote Systems

& Terminals

' Other... ' Alt+Shift+Q, Q
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_13.  In the Show view dialog, expand General
_ 14, Select Project explorer from the list
__15.  Click the OK button.

© show View O X

type filter text

v [ General A

|| Bookmarks
4" Classic Search

-

Console
Enterprise Explorer

| Error Log
GMF Dashboard
Internal Web Browser
Markers
Navigator

e @9

QOutline
Palette
(2. Problems

oo

*
0,0

= Progress

(LC, Project Explorer)
] Properties
4’ Search

03 Snippets

(—— e

This adds the Project explorer view to the Remote System Explorer perspective.

__16. In the Project explorer view, expand the appdiag project.

You see two files in the project:
(1) The appmdl file contains the model information.
(2) The appmdl_diagram file contains layout information and any notes you have
added to the diagram.
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@ Remote System Details &) Tasks |(‘—7 Project Explorer '.;3)'_[
v = |

:53 ApplicationModel.appmdl
L% ApplicationModel.appmdl_diagram

_17.  To reopen the diagram, double click on one of the two files.

7.2 Saving a diagram as a text file

Next, you will save the diagram as a text file. Do this when you want a format that you can easily share,
duplicate, and search.

Tip:
Make sure you click outside of the member rectangle on the canvas

_ 1. Right-click on a blank section of the canvas and click File > Save As Text File.

15 ApplicationModelappend|_diagram
r Frle ’ Save As Image File.. |
= % Select v/ @ Print.
Change Layout. Save As Text File..
‘_ 5 Arrange All N—
OpenPart
View ’
% Zoom ’
3 Collapse All

The Save As Text File dialog box opens.

_ 2. Enter a Folder and File name (c:\temp and SLTPARTR, check box to Overwrite)
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3. Click OK.

7,

m— ——— m— ~

72 Save As Teat lle 5™

Fo&d{. c\emp Browse,.

File Nam¢= SLTPARTR

ﬁmuc exssting files withosst waming

',

[ ok || comel

To look at the file content, open it in the workbench.
4. In the RSE view, expand Local
5.  Expand Local Files --> Drives --> to the directory you saved the file to.

# Remote Systems |G Tean

4 New Connection -
+ O Local
« %% Local Files
¥ My Home
-5 ("l
laedbb20ea3fedqbidele8?
8Ginfo
J 1IBM
18MCS
— epud
Perflogs
J Program Fles

Program Files (xB86)

demoCentralTn5250 cer
DemoCentralTn52505SL.paf
HATSDemopl2

RodsNotes.txt
SLTPARTR bt
\

Windows

IBM Software
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__ 6. Double click the file.
The default editor will open and show the file content.

A Remote Systems < Tea ) || SLIPARTR tet 2
é | | Agplication Topology »
v & New Coennection ~
L | (S SIIII I ————
D Llocal

v B Local
v % Local Fles SLTPARTR
; My Home Location: cuticulal.lBM Desoastration Server:cos.ibe.etools.iseries
v % Dives
v 4 C Main Entry Point: SLYPARTR
Peflog
Program Fies

Program Fies («86)

v '|II|

Users 1dsfl

Windzwa . ALTAART
A dows30Lie ClosePart
Windeows 1 Uggrade IndPgm

PRI ATrdpobcy ire tndPge

X Sybnkxml SLTPARTR

Tx Local Shels Process
v I8 BM Demonstraticn Server OpenPart
v B Otiects Process

o e SLTPARTR
Aa Work weth Sbranes ReadPart

S Work with objects. SLTPARTR
14) Work weth members
> ‘ Libeary bst Calls:
QSYS."Sbprod-sys
QSYS2"kb grod 9y
CHLPSYS. "W prod-sys
QuUs *ibprod-ays
QOEVIOOLS. "lb.prod-prd
RSELABOY, Wb test-cur

4 CLBATCH “pgm.cle

LEREREY

s CLCL."pygmuclie

1 CLRY."pgm.cile

In the next task you will save the diagram as an Image file.

7.3 Saving a diagram or parts of a diagram as an image file

You might do this to share or embed an entire diagram or a portion of a diagram as a part of a larger
document.

This is very similar to saving a diagram as text file, which you just did in the previous steps. We show
you briefly how to save an entire diagram and go through the detailed steps of saving portions of a
diagram.

For saving as an image, you can select from multiple file types you want to save to:
1. gif

2. bmp

3. jpeg

4. jpg

5. svg
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6. png
7. pdf

In addition, you can specify to create HTML to easily show the image in a web browser.
To save the entire image file as an image to be shown in a browser:

Specify the target directory

Select to Export to HTML
Click the OK button.

Right click on the canvas of the diagram outside of the member rectangle
Select File --> Save as image file..

1
2
3
4. Specify which image format you want
5
6

) Save As Image File

File Name=  ApplicationModelntm

Snage FC””"
verarile exsting file wathout waming
port 1o HTML

Browse.,

Cancel

To display the file in a browser:

IBM Software
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T

Go to Windows Explorer, double click the file. Default Web Browser will open the html file.

@ Moxzitta Firefox
Eile Edit View Higtory Bookmarks Jools Help
C I file///C/ Temp/ApplicationModel htm| 3 P
IBM - United States
file:///C:/Tem...ionModel. htmi
~
1 SLTPARTR
¥ Openpart
: ReadPart
10 Line
S
INZSR
»" Process ¢
Main entry powst f " }
+ i - b
Parts Sele - SLYPARTR } EndPgm ClosePart
i
T Biasn
Done
Tip:

If you use RSE to open the file, the default for opening an html file is to use
the page designer tool. Instead of displaying the html file in a browser you
actually open the default editor for html files in the workbench in Split view.

To open the file in a browser, right click in RSE explorer, on the file and
use the open with --> Web Browser action.

Let’s save a partial diagram in an image file. For this to work you have to select all the diagram
elements you want to see in the image.

You can use the typical multiple selection capability in Windows, pressing the CTRL key while
clicking on objects in the diagram to select them; or you can drag a box over the area that
contains the objects you want to select them.
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12,

Drag a box around every object in SLTPATR and the notes that you added.

1" thgpkatarion.xond dagan

‘ OperPut Soand-lorm ecte For genenc bt for this applcaten

b peesmt

A

L4 o
Lj s | t i
Man ety pont oy
Parts selaction
frigy 0
L.E"tﬁ.'” )}
0 -
2w o oww )
\_ Fon

4

All the objects inside the area will be selected.
Right click one of the selected objects
Click File — Save as image.

. Comvecton ne [

éi £, ASS e
e Eﬁk—m—n
oy 1) Rvoms Frogames view

o p Y

n
— g e e
B aman b @ L v b £ onern
*11.' 0

Enter a Folder and File name
Select the Image Format

IBM Software
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13. Click the OK button.

T 5ov A mage e =
Fol CAtemp Browse.
File Name| ApplicationModel_1.hmi
Image Formag JPG -
v rite exsting file wathout warming
xport 10 HTML
[ ok || cancet

Have a look at the image to complete this module.

=
Csertpommasio By D « G | 3 Cunert Admmnsr an
Cormecton Lre .E‘ *INZSR
Evom
Man avtry poet e

e 5 g . — .

Parts Selecton program ;grum ! ‘S@‘"" 4 *i ,M J
E v

Now you are ready to do some printing.
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8 Printing an application diagram

In this module, you will print an application diagram.

Tip:
e
o You will only be able to print a diagram if you have a printer configured
and connected to your workstation. If you are using one of the images
provided by the developerWorks EM Sandbox portal, this is not the

case, so you can skip this module.

To print an application diagram:

_ 1. Make sure the diagram you want to print is selected by clicking its tab.
_ 2. On the workbench menu, click File > Print.

@ RDiLabs - Remote System Explorer - The application diagram for SLTPARTR.
@ Edit Diagram Navigate Search Project Run Window Help

New Alt+Shift+N >
Open File...

4 Open Projects from File System... =

-]

Close Ctrl+W fL
Close All Ctrl+Shift+W
Save Ctrl+S

@ SaveAs..
Save A Ctrl+Shift+S
Rename F2
Refre F5
Convert Line Delimiters To >

]

Dane Setuin

IBM Software

_ 3. To print just the selected SLTPARTR diagram, select the Current diagram radio button.
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4. Click OK.

£

3 Print Diagram
Pranter

Name: | Microsoft XPS Document Writer v | Propenies.
Diagram Print Range

@ Current diagram

e iected QEaarams.

Scaling

9 Adjust 10 percentage of normal sizes 100

Fit toc Pages wides | Pages taik: |
Print range Copies
o Al Number of copies: 1 =
Pages
U I |
trome| 3 rocl 3 l l I ! |>| Collate
Print Preview..
X/ » oK [ Canced

You have printed an application diagram.

Tip:
EEt In the Print dialog you have two options to print multiple diagrams
at once. You can also scale the diagram to fit the page size you
are using
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Congratulations!

You have successfully completed the Introduction to Application Diagram Viewer lab exercises.

You have completed working with the Application Diagram Viewer. You learned how to launch an
application diagram, using a Source Call diagram and a Program Structure diagram. You changed
the preferences and layouts of those diagrams.

You also learned how to work in the application diagram’s canvas and its Outline view to easily navigate
to areas of interest and launch the source editor to work with the source members related to the nodes and
connections in the diagram.

Finally, you saved the application diagrams in different formats to re-use the diagrams later or to share
them with other people.

We recommend that you move on to the next lab in the sequence; or browse the list of labs on Rational
Developer for i - Hands-On Labs at http://ibm.biz/rdi_labs to choose a lab of interest.

More information, material and opportunities to discuss the product can be found at our RDi Hub:

http://ibm.biz/rdi _hub
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Appendix A Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
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been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those
products.

All statements regarding IBM's future direction and intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an actual
business enterprise is entirely coincidental. All references to fictitious companies or individuals are used
for illustration purposes only.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.
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Appendix B Trademarks and copyrights

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:

IBM AIX Cics ClearCase ClearQuest Cloudscape
Cube Views DB2 developerWorks DRDA IMS IMS/ESA
Informix Lotus Lotus Workflow MQSeries OmniFind

Rational Redbooks Red Brick RequisitePro System i

System z Tivoli WebSphere Workplace System p

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other
countries, or both and is used under license therefrom.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United
States, other countries, or both. See Java Guidelines

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other countries.
Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

ITIL is a registered trademark and a registered community trademark of the Office of Government
Commerce, and is registered in the U.S. Patent and Trademark Office.

IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications
Agency which is now part of the Office of Government Commerce.

Other company, product and service names may be trademarks or service marks of others.
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© Copyright IBM Corporation 2021

The information contained in these materials is provided for
informational purposes only, and is provided AS IS without
warranty of any kind, express or implied. IBM shall not be
responsible for any damages arising out of the use of, or otherwise
related to, these materials. Nothing contained in these materials is
intended to, nor shall have the effect of, creating any warranties or
representations from IBM or its suppliers or licensors, or altering
the terms and conditions of the applicable license agreement
governing the use of IBM software. References in these materials
to IBM products, programs, or services do not imply that they will
be available in all countries in which IBM operates. This
information is based on current IBM product plans and strategy,
which are subject to change by IBM without notice. Product
release dates and/or capabilities referenced in these materials may
change at any time at IBM’s sole discretion based on market
opportunities or other factors, and are not intended to be a

commitment to future product or feature availability in any way.

IBM, the IBM logo and ibm.com are trademarks or registered
trademarks of International Business Machines Corporation in the
United States, other countries, or both. If these and other IBM
trademarked terms are marked on their first occurrence in this
information with a trademark symbol (® or ™), these symbols
indicate U.S. registered or common law trademarks owned by IBM
at the time this information was published. Such trademarks may
also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at
“Copyright and trademark information” at

ibm.com/legal/copytrade.shtml

Other company, product and service names may be trademarks or

service marks of others.

@ Please Recycle



